
 

ADDING INTERACTIVITY TO YOUR PROJECTION 

You’ve several options for adding interactivity or it’s completely fine to have no interactivity at all if your idea doesn’t need it. 

Note: Some of these options look very complicated when written out in full.  They’re surprisingly straight-forward and as we’re 

in a workshop I’ll be here to show you the ropes. 

INTERACTIVITY OPTIONS: 

1. Allow the user to use the mouse to click on parts of the interactive. 

2. Allow the user to use the keyboard to advance to different slides. 

3. Create 2D / 3D physical buttons or use conductive paint 

Using the mouse is most straight-forward as this uses a built-in feature of PowerPoint called hyperlinks.  It only takes a few 

minutes to set this up.  I’d recommend at the very least having a play with this feature. 

Using the keyboard is more complicated since PowerPoint doesn’t support this as standard.  This requires a combination of an 

add-on, some custom macros that I’ve written and a small about of macro editing! 

Using physical buttons is most complicated as it builds on the keyboard work.  It’s probably the most satisfying for the user and 

really breaks any connection that the end user would guess that you’re using PowerPoint! 

As is always the case – focus on the end experience of what you’re trying to achieve instead of the technology 

Follow the tutorial for whichever path you require.  But if you need some assistance please just give me a shout and I’ll pop over. 

MOUSE 

This is the most straight-forward and uses a PowerPoint feature known as hyperlinks. 

In a standard PowerPoint presentation whenever you click somewhere on the screen it takes you to the next slide.  We want to 

do two things: 

• Disable this ‘advance slide’ when mouse is clicked behaviour 

• Add new functionality that when you click on something on the page it takes you to a specified slide (hyperlinks) 

DISABLE FORWARD ADVANCEMENT 

On your ‘Main Menu’ slide, go to the ‘Transitions Tab’ and untick ‘Advance Slide: On Mouse Click’ 

 

Start your presentation again and confirm that clicking on the screen does nothing.  You can still move through your slide deck 

with the arrow keys. 

ADD A HYPERLINK 

You can add this functionality to any object in the slide.  Right click on an object – in my example I’m using an Image (taken from 

the BMAG website). 



 

 

On the left of this dialog – chose ‘Place in This Document’. 

You’ll then be presented with a list of all your slides.  It is simply a case of highlighting the name of the slide that you want to 

jump to.  Then click ‘OK’. 

You’ll get to see a ‘Slide Preview’ in the right-hand pane – so you can double check that you’ve selected the right slide. 

You can start your presentation again with F5 and confirm that clicking on your ‘Image Button’ takes you to the target slide.  You 

should also double-check that clicking other locations on the slide does nothing at all. 

Note: a common gotcha happens when you’re working with Buttons that contain text. It is very easy to make the mistake of 

applying the hyperlink to the text instead of the entire button.  If this happens, you’ll see that the text becomes underlined.  Just 

remove the hyperlink and make sure that you right click on the edge of the Button object away from the text. 

KEYBOARD 

This is more complicated as PowerPoint doesn’t support this feature out-of-the-box (other Office products do!).  So it requires a 

bit of a workaround.  

N.B. If this workshop / tutorial becomes popular then I’ll create a freeware tool / PowerPoint add-on to handle this (with a 

decent interface). Since this is the first time through, we’ll have to make do with this workaround. 

CODING!?!  

So this workaround requires us to do some (light) programming in a language called VBA (Visual Basic for Applications).  All 

Office Products have this language running in the background which allows you to do more of less anything with the software – 

if you’re happy getting your hands a little dirty. 

For the record VBA is a pretty awful language but I’m not expecting you to learn any of it – I just want you to copy and paste a 

few lines and make a few changes. 

ADD THE DEVELOPER RIBBON (THIS IS DONE FOR YOU ALREADY)  

In case you want to do this on your own machine: 



 
• Right click on the Ribbon and select ‘Customise the Ribbon’ 

• On the pop-up window makes sure the Developer option is ticked. 

• Click Okay 

 

This will give you access to the ‘Developer’ tab.  Just click on ‘View Code’ whenever 

you need to edit the code. 

 

 

REFERRING TO SLIDES:  THE SLIDE ID 

What we want to say is things like: 

if the user presses the J Key then jump to the end of the story slide.   

We just need to write this in a way that PowerPoint understands – so we need a way to 

refer to slides.  There are many ways to do this – but to keep things easy – we’re going to 

use a property known as SlideID.  This is a unique number given to every slide when it is 

created. 

Note: it isn’t its position number – i.e. third slide is 3. Otherwise every time we inserted a 

slide, we’d need to change all our code. 

Once a slide is given its SlideID it will always keep that number 

You can obtain the SlideID with the keyboard shortcut Ctrl + Shift + N 

CONFIGURING THE KEYPRESSES 

Let’s return to our question of: 

 If the user presses the J Key then jump to the end of the story slide. 

We need to know the SlideID of the source slide and the SlideID of the destination slide (end of story). 

Let’s say we’re on SlideID 256 (source) and we want to go to SlideID 258 (destination).  You also know how to bring up the code 

using ‘View Code’ on the Developer tab. 

Unless you’re particularly interested you can ignore most of the code – and simply scroll right to the bottom where you’ll find 

the code for Keypressed:  

Sub KeyPressed(key As String) 

    Dim sld As Slide 

    Set sld = ActivePresentation.SlideShowWindow.View.Slide 

    'sld = Application.ActiveWindow.View.Slide 

     



 

    Dim slideID As Integer 

    slideID = sld.slideID 

   

You can ignore all of this and just focus on the bit below this: 

 

    If slideID = 256 Then 

        If key = "j" Then GotoSlide (258) 

        If key = "u" Then GotoSlide (259) 

    End If 

 

Hopefully, someone in your group has written some code before and this won’t be a huge shock.  A little description of what 

happens is: 

• You can see the first line is a check to make sure we’re currently viewing the source slide (256). 

• The next line checks if the user has pressed j and if they have to go to the destination (258). 

• The line afterwards does something similar when the user presses u. 

If that’s all the behaviour you want then great – you can delete all the other examples.  In all likelihood you’ll probably have a 

few more slides – so you’ll come back and add to this. 

ALTERNATIVE KEYBOARD BEHAVIOUR 

So you’ve got two options when setting up your keyboard behaviour.   

1. Each individual page – responds to the individual keypresses. This is like our Choose Your Own Adventure Example.  On 

each page Option A goes one way and Option B goes another way. 

2. Each key is mapped to a particular page.  This is like our shapes example.  Each keypress maps to a different high-

lighted area. 

What we described in this tutorial so far covers option 1. 

If you’re keen to do something closer to option 2 then you’ll want code similar to this: 

 

    ' SpotLight 

    If slideID = 271 Or slideID = 272 Or slideID = 273 Or slideID = 274 

        If key = "j" Then GotoSlide (272) 

        If key = "u" Then GotoSlide (273) 

        If key = "h" Then GotoSlide (274) 

        If key = "y" Then GotoSlide (275) 

    End If 

 

Note: if you want the behaviour to work anywhere in your slideshow then you don’t even need the line beginning with If.  That’s 

only there as my example is in a single PowerPoint slideshow with many different examples. 

  



 
ADD-IN: OFFICEONE SHORTCUT MANAGER 8 (ALREADY DONE FOR YOU) 

This workaround also uses a third-party plug-in called: OfficeOne Shortcut Manager 8 for 

PowerPoint.  It allows you to create your own shortcuts.  We’re using the functionality that 

allows you to link keypresses directly to trigger VBA Macros.  I’ve already set this up for you – 

so you don’t need to. 

If you do want to look into it further – choose the ‘Home Tab’ and you’ll find it on the far right. 

PHYSICAL ALTERNATIVES 

   

Please read the keyboard guide above first before embarking on this – unless you’re going the simplified Makey-Makey 

approach – see below.  The reason that you need to understand the keyboard section first is that we’re providing this physical 

interactivity by ‘tricking’ PowerPoint into thinking it has another keyboard attached. 

You have a choice of two devices: either a Makey-Makey or Bare Conductive Touchboard.  Both allow us to connect physical 

devices to the computer and have them think that it’s just another keyboard attached. 

MAKEY-MAKEY CLASSIC –  MAKE ANYTHING INTO A KEY 

Makey-Makey works by opening and closing of circuits. Whenever a circuit is closed it’s like a key on the keyboard has been 

pressed.  The magic is that Makey-Makey allows just about anything to become that button providing it can make the circuit: tin 

foil, people, food, plants etc.  The trick to remember is that you must create an entire loop to close the circuit.  So in the banana 

piano example (the Makey-Makey classic) – the player holds the orange in their right hand and completes a circuit by pressing 

banana keys with their left hand. 

   

BARE CONDUCTIVE TOUCHBOARD 

So the BareConductive differs in a few ways. Firstly, instead of creating a complete circuits, the BareConductive uses capacitance 

to detect touches.  This means that you doesn’t need to create a complete circuit – its more similar to the touch screen on your 

phone.  Secondly, it is set-up to run some built in audio software.  This software triggers mp3 files on an SD Card when the 



 
buttons are triggered.  This is really useful as you can create a number of things out-of-the-box with needing a computer.  For 

example a touch triggered, audio-enabled poster. 

   

So what I’ve done is replace the default software with an alternative that makes the BareConductive into a PC keyboard.  So it’s 

a bit more like the Makey-Makey except that it uses capacitive touch. 

The short tutorial is here (if you want to do it yourself):  

www.bareconductive.com/make/the-touch-board-as-an-hid-keyboard/ 

This is actually similar to another Makey-Makey product called the ‘Makey-Makey Go’.  Whereas the ‘Makey-Makey Go’ only 

emulates a single button – the BareConductive has 12 on a single device. 

E0 E1 E2 E3 E4 E5 E6 E7 E8 E9 E10 E11 

J U H Y G T F D E S W A 

The ordering looks a bit weird – as apparently this is a useful setup for GarageBand. If you need these remapped to something 

else then let me know and I can help you with that. 

SIMPLIFIED MAKEY-MAKEY APPROACH 

While I said that PowerPoint doesn’t respond to key-presses – that’s not entirely true.  It does listen for Space, Left, Right, Up 

and Down (among a few others).  The ones which might be useful are: 

• Next Slide: Right, Down or Space 

• Previous Slide: Left or Up 

If you can make your interactive work with Next and Previous then you can ignore all that complexity. 

Makey-Makey can also provides a mouse click. So it might be possible to leave the mouse cursor at a fixed location and use it to 

click on hyperlinks! 

LIMITED NUMBER OF PHYSICAL BUTTONS 

If you do go down the route of making physical buttons or using conductive paint – then you might want to spend a few minutes 

thinking about exactly what controls you provide your user with. 

Some ideas: 

• a set of controls that map to specific slides (like the High-lighting example) 

• a fixed set of controls (move left, move right, zoom in, zoom out) 

• a set of choices (A, B, C, D) 
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